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Einleitung
Willkommen im Kreis der Agilent VEE-Nutzer!Agilent Visual Engineering 
Environment (VEE) ist eine leistungsfähige visuelle Sprachumgebung, mit 
der Sie Ihre Programme erheblich schneller entwickeln können. Damit 
Sie möglichst schnell mit Agilent VEE starten können, wird in dieser 
Anleitung gezeigt, wie die neue Software installiert und verwendet wird. 
Außerdem beinhaltet diese Anleitung zwei Übungseinheiten, in denen 
erläutert wird, wie über die USB-Schnittstelle auf ein Instrument zuge-
griffen und wie eine Wellenform von einer virtuellen Quelle generiert und 
angezeigt werden kann.

Installieren von Agilent IO Libraries
Die Agilent IO Libraries Suite erhalten Sie beim Kauf von Agilent VEE. 
Mit dieser Software können Sie über serielle, USB-, GPIB- oder LAN-
Schnittstellen auf Instrumente zugreifen. 

Die Agilent IO Libraries Suite 15.0 muss installiert sein, bevor Agilent VEE 
installiert wird, wenn Sie über Agilent VEE auf ein Instrument zugreifen 
müssen. Wenn Sie keine Instrumente verwenden, können Sie sich jedoch 
gegen die Installation der Agilent IO Libraries Suite entscheiden. 

Führen Sie folgende einfache Installationsschritte aus:

1 Legen Sie die Agilent IO Libraries Suite-CD in das CD-ROM-Laufwerk 
ein. Klicken Sie im Fenster der Agilent IO Libraries Suite 15.0 auf Click 
Here to Install Now, um mit der Installation zu beginnen.
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2 Der InstallShield® Wizard führt Sie durch die Installationsvorgänge. 
Klicken Sie auf Next, um die Standardeinstellungen zu übernehmen 
und die Installation abzuschließen.

3 Das Fenster Agilent Connection Expert Welcome Screen wird ange-
zeigt. Mit dieser Anwendung werden die Instrumente konfiguriert, die 
an den PC angeschlossen sind. Sie können dieses Fenster schließen, 
bevor Sie den nächsten Schritt ausführen.
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Installieren von Agilent VEE Pro oder Agilent VEE Express
1 Legen Sie die Agilent VEE-Installations-CD ein, und klicken Sie auf 

Install Agilent VEE Pro 9.0 bzw. Install Agilent VEE Express 9.0. Der 
InstallShield® Wizard führt Sie durch die Installationsvorgänge. 

Informationen zu den Produktunterschieden finden Sie auf Seite 19.

2 Der InstallShield® Wizard prüft nun, ob Agilent IO Libraries Suite 15.0 
installiert ist. Ist dies nicht der Fall, wird das folgende Meldungs-
fenster angezeigt.

Beachten Sie, dass Agilent IO Libraries Suite 15.0 eine Voraussetzung für 
den Zugriff auf Instrumente über Agilent VEE ist. Darum installieren Sie 
bitte nach Abschluss dieser Installation Agilent IO Libraries Suite 15.0 
oder höher.

Klicken Sie auf OK.Der InstallShield® Wizard prüft nun, ob Microsoft .NET 
Framework 3.5 installiert ist.
4 Agilent VEE Pro 9.0 und Agilent VEE Express 9.0 – Kurzanleitung



3 Falls Microsoft .NET Framework 3.5 nicht installiert ist, werden Sie in 
einem Dialogfenster gefragt, ob Sie es installieren möchten. Klicken Sie 
auf Yes, um Microsoft .NET Framework 3.5 sofort zu installieren. Nach 
der Installation wird die Agilent VEE-Installation automatisch fortge-
setzt. Wenn Sie auf No klicken, wird die Agilent VEE-Installation abge-
brochen.

Wenn Microsoft .NET Framework 3.5 installiert ist, führt der 
InstallShield® Wizard Sie direkt zum nächsten Schritt, der Installation 
Ihrer Agilent VEE-Auswahl in Schritt 1.

4 Klicken Sie auf Next, wenn das folgende Dialogfenster angezeigt wird.

5 Akzeptieren Sie den Lizenzvertrag, wenn das License Agreement-
Dialogfenster angezeigt wird, und klicken Sie auf Next.
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6 Geben Sie Ihren Namen, Unternehmensnamen und Produktschlüssel 
ein, wenn das Customer Information-Dialogfenster angezeigt wird, und 
klicken Sie auf Next. Den Produktschlüssel finden Sie im Agilent VEE 
Pro oder Agilent VEE Express Product Key Certificate. 
6 Agilent VEE Pro 9.0 und Agilent VEE Express 9.0 – Kurzanleitung



7 Klicken Sie auf Next, um die Standardeinstellungen zu akzeptieren, 
wenn das folgende Dialogfenster angezeigt wird. 

8 Wählen Sie Typical Setup, wenn das Setup Type-Dialogfenster angezeigt 
wird, und klicken Sie auf Next, um die Installation abzuschließen.
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Starten von Agilent VEE Pro oder Agilent VEE Express
Wechseln Sie zu All Programs (Alle Programme) > Agilent VEE Pro 9.0 > VEE Pro 
9.0 bzw. All Programs (Alle Programme) > Agilent VEE Express 9.0 > VEE Express 
9.0, um Agilent VEE Pro bzw. Agilent VEE Express zu starten.

Über die Begrüßungsseite von Agilent VEE Pro oder Agilent VEE Express 
können Sie auf die Demos, die MATLAB-Beispiele (nur in Agilent VEE 
Pro verfügbar) sowie Beispielprogramme zugreifen. Nachdem Sie sich die 
Begrüßungsseite angesehen haben, können Sie diese schließen. 

Beispielprogramme können Sie auch über die Menüleiste öffnen. Wenn 
Sie ein Beispielprogramm öffnen möchten, wählen Sie File > Open Example 
... oder Help > Open Example ... aus.

Ausgabefenster 
(Output)

Arbeitsbereich

Program 
Explorer

Eigenschaften-
fenster 

Symbolleiste

Statusleiste

Menüleiste

Begrüßungs-
seite
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Zugreifen auf ein Instrument - Übungseinheit
In dieser Übungseinheit wird über die USB-Schnittstelle eine Verbindung 
zu einem Instrument hergestellt. Führen Sie die weiteren Schritte erst 
aus, nachdem Sie sich vergewissert haben, dass die Agilent IO Libraries 
Suite 15.0  installiert ist. 

Wenn Sie kein USB-Instrument haben, können Sie zu Schritt 3 springen. 
Die Übungseinheit ist ab diesem Schritt für ein GPIB-Instrument gleich. 

Die folgenden Screenshots wurden Agilent VEE Pro erstellt. Screenshots 
für Agilent VEE Express sehen ähnlich aus.

1 Stellen Sie über einen USB-Anschluss des PCs eine Verbindung zum 
Instrument her. Schalten Sie dann das Instrument ein. Möglicherweise 
wird der Assistent für das Suchen neuer Hardware (Found New 
Hardware Wizard) angezeigt. Folgen Sie dem Assistenten, indem Sie 
auf Next klicken.

2 Wenn das Dialogfenster „Assign USB device alias“ angezeigt wird, müs-
sen Sie auf OK klicken, um die Schnittstelle im System zu registrieren. 
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3 Starten Sie Agilent VEE Pro oder Agilent VEE Express, sofern Sie dies 
nicht bereits getan haben. Klicken Sie in der Symbolleiste auf das Sym-
bol Instrument Manager .

4 Das Toolfenster Instrument Manager wird angezeigt. Klicken Sie auf 
die Schaltfläche Find Instruments , um automatisch alle Instru-
mente zu ermitteln,

die mit Ihrem PC verbunden sind. Klicken Sie auf Yes, wenn das 
Popup-Dialogfenster „Identify Instrument“ angezeigt wird. Dadurch 
wird das Instrument an der USB-Schnittstelle automatisch erkannt 
(identifiziert). In diesem Beispiel ist ein digitales Agilent 34410A Multi-
meter vorhanden.

5 Klicken Sie mit der rechten Maustaste im Bereich „Instrument List“ 
auf den Eintrag für das neue Instrument (newInstrument). Wählen Sie 
anschließend Create Direct I/O Object im geöffneten Kontextmenü, um 
das Direct I/O-Objekt für das ausgewählte neue Instrument 
(newinstrument) auf dem Arbeitsbereich zu platzieren. Über dieses 
Objekt können Sie Befehle an das/vom Instrument senden/empfangen.
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6 Doppelklicken Sie auf die blaue Transaktionsleiste des Direct 
I/O-Objekts, damit Sie ihm eine Transaktion hinzufügen können.

7 Geben Sie im Dialogfenster I/O Transaction die Zeichenfolge "*IDN?"  
ein. Geben Sie auch die Anführungszeichen ein (siehe Abbildung). Wäh-
rend der Eingabe wird möglicherweise eine Liste verfügbarer SCPI-
Befehle angezeigt. Sie können den gewünschten Befehl wählen, anstatt 
den ganzen Befehl einzugeben. Klicken Sie zum Fortsetzen auf OK.

*IDN? ist einer der Standardbefehle für programmierbare Instrumente 
(SCPI - Standard Commands for Programmable Instruments). Dieser Befehl 
fragt die Identifikationsszeichenfolge eines Instruments ab.

8 Nach dem Senden der Abfrage "*IDN?" an das Instrument muss dessen 
Antwort gelesen werden. Doppelklicken Sie auf das Textfeld des newIn-
strument-Objekts, damit Sie eine neue Transaktion hinzufügen können. 
Wählen Sie jezt die Transaktion READ zur Ausgabe eines Textes im STRING 
FORMAT (Zeichenfolgenformat) an einem Ausgabeterminal x. Der Aus-
gang x wird automatisch erstellt, sobald Sie auf OK geklickt haben.
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9 Wählen Sie Display  AlphaNumeric aus und ordnen Sie ein AlphaNume-
ric-Objekt im Arbeitsbereich rechts neben dem Direct I/O-Objekt an.

10 Das Direct I/O -Objekt soll nun mit dem AlphaNumeric-Objekt verbun-
den werden. Platzieren Sie den Cursor neben dem Ausgang des Direct 
I/O-Objekts. Es wird ein quadratisches Symbol angezeigt. Klicken Sie 
mit der linken Maustaste und ziehen Sie eine Linie zum Eingabean-
schluss (input terminal, Eingang) des AlphaNumeric-Objekts. Klicken 
Sie erneut mit der linken Maustaste, um die Verbindung abzuschließen.

11 Führen Sie das Programm aus, indem Sie in der Symbolleiste auf das 
Symbol Run  klicken.
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12 Das AlphaNumeric-Objekt zeigt die Identifikationszeichenfolge an, die 
das Instrument ausgegeben hat (siehe folgende Abbildung).

13 Zum Speichern des VEE-Codes wählen Sie File > Save As aus. Geben Sie 
der Datei den Namen Uebungseinheit 1.vee.
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Virtuelle Quelle (Virtual Source) - Übungseinheit
In dieser Übungseinheit generieren Sie eine Wellenform aus einer virtuel-
len Quelle und zeigen diese Wellenform an. Es ist kein Instrument erfor-
derlich.

1 Wenn im Arbeitsbereich von Agilent VEE Pro oder Agilent VEE 
Express ein Programm vorhanden ist, wählen Sie File > New aus. 
Wählen Sie dann Device > Virtual Source  Function Generator aus, und 
ordnen Sie im Arbeitsbereich ein Function Generator-Objekt an.

2 Der Funktionsgenerator erzeugt standardmäßig eine virtuelle 
Cosine-Wellenform (Kosinus) mit der Frequenz (Frequency) 200 Hz 
und der Amplitude 1.  
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3 Wählen Sie Display > XY Trace aus, und legen Sie ein XY Trace-Objekt 
rechts neben dem Function Generator-Objekt ab. 

4 Verbinden Sie den Ausgang des Function Generator-Objekts mit dem 
Eingang des XY Trace-Objekts. Platzieren Sie den Mauscursor neben 
dem Ausgang des Function Generator-Objekts. Es wird ein quadrati-
sches Symbol angezeigt. Klicken Sie mit der linken Maustaste und zie-
hen Sie eine Linie zum Eingang des XY Trace-Objekts. Klicken Sie 
erneut mit der linken Maustaste, um die Verbindung abzuschließen.

5 Klicken Sie in der Symbolleiste auf das Symbol Run  . Danach wird 
die Kosinuswellenform im XY Trace-Objekt angezeigt. 
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6 Wählen Sie Display > Spectrum (Freq)  Magnitude Spectrum aus und legen 
Sie im Arbeitsbereich ein Magnitude Spectrum-Objekt unter dem XY 
Trace-Objekt ab.

.

7 Ziehen Sie gemäß der in Schritt 4 beschriebenen Methode des Links-
klickens und Ablegens eine zweite Linie vom Ausgang des Function 
Generator-Objekts zum Eingang des Magnitude Spectrum-Objekts.

8 Klicken Sie auf das Symbol Run , und sehen Sie sich die Anzeige 
des Magnitude Spectrum-Objekts an. Da die Wellenform einer 200-Hz-
Kosinuswelle entspricht, zeigt das Magnitude Spectrum-Objekt eine 
vertikale Linie bei der Frequenz 200 Hz an.
16 Agilent VEE Pro 9.0 und Agilent VEE Express 9.0 – Kurzanleitung



9 Ändern Sie die Funktion im Generator für virtuelle Funktionen in eine 
rechteckige (Square) Wellenform. 
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10 Klicken Sie auf das Symbol Run  und beobachten Sie den Unter-
schied. Agilent VEE bietet Ihnen die Möglichkeit, eine Signalquelle 
gleichzeitig in mehreren Grafikdarstellungen zu analysieren. 

11 Zum Speichern des VEE-Codes wählen Sie File > Save As aus. Geben Sie 
der Datei den Namen Uebungseinheit 2.vee.
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Unterschiede zwischen Agilent VEE Pro und Agilent VEE 
Express

In der folgenden Tabelle sind die Unterschiede zusammengestellt, die es 
zwischen Agilent VEE Pro und Agilent VEE Express gibt.

Agilent bietet auch die Versionen Agilent VEE Student und Agilent 
Education für Benutzer im Ausbildungsbereich an.

Funktionen Agilent VEE Pro Agilent VEE 
Express

Schnittstellen GPIB, LAN, RS-232, 
VXI, PXI, SCXI

USB
(Agilent 

USB-Geräte nur in 
LiveMode)

MatlabScript-Objekte und Matlab-
Script-Modul

Erstellen von Laufzeitversionen von Agi-
lent VEE-Programmen und geschützten 
(secured) Versionen von Agilent 
VEE-Objekten

Programmgesteuertes Ändern von Instru-
mentenadressen

Funktion Callable Server („Aufrufbarer Ser-
ver“), d. h., Agilent VEE kann als ActiveX-
Automatisierungsserver aufgerufen werden

Verwenden von fernen Funktionen, d. h., es 
können Benutzerfunktionen importiert 
werden, die in einem anderen Agilent VEE-
Prozess auf einem fernen Hostcomputer 
ausgeführt werden

Weitere Funktionen
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Agilent VEE 9.0 – neue Eigenschaften
Multithreading –Diese Funktion kann die Leistung Ihres mit Agilent VEE 
erstellten Systems steigern. Mit dieser Funktion können Sie mühelos 
mehrere Threads in einem Agilent VEE-Programm erstellen, um kürzere 
Ausführungszeit, höhere Reaktionsgeschwindigkeit sowie höheren 
E/A-Durchsatz zu erzielen. Mit der Multithreading-Funktion wird außer-
dem ein neuer Ausführungsmodus eingeführt. 

Multicore-Programmierung – Mit dieser Funktion erhalten Sie die Fähig-
keit zur Multicore-Programmierung. Sie können die Leistung Ihrer Multi-
thread-Programme sogar noch weiter steigern, indem Sie bestimmten 
CPU-Kernen verschiedene Threads zuweisen, falls Ihr Computer über 
eine Multi-Core-CPU verfügt. 

SCPI-Vervollständigung – Mit dieser Funktion können Sie mühelos einen 
SCPI-Befehl aus einer Liste auswählen, die während der Eingabe eines 
SCPI-Befehls im IO Transaction Object angezeigt wird. Eine Beschreibung 
des ausgewählten SCPI-Befehls wird ebenfalls angezeigt. Der Zeitaufwand 
zur Suche in SCPI-Handbüchern und Überprüfung von Syntaxfehlern 
wird so deutlich reduziert. Darüber hinaus können Sie sogar Ihre eigene 
SCPI-Befehlsdatei wählen, anstatt die automatisch von VEE ausgewählte 
standardmäßige SCPI-Befehlsdatei zu verwenden. 

Private UserFunction – Agilent VEE 9.0 bietet einen neuen Typ von 
UserFunction: Private UserFunction hilft Ihnen, Ihre VEE-Programme 
besser zu modularisieren und für umfangreichere Anwendungen zu ver-
kapseln.

Conditional Breakpoint – Mit Conditional Breakpoint sind Sie in der 
Lage, Bedingungen und Zähler für einen Haltepunkt festzulegen and 
anzugeben, was beim Erreichen eines Haltepunkts geschehen soll. So 
haben Sie größere Kontrolle über den Debuggingprozess und erzielen eine 
höhere Effizienz.

Breakpoints-Fenster – Im Breakpoints-Fenster können Sie alle Halte-
punkte in Ihrem VEE-Programm beobachten und kontrollieren. Sie kön-
nen Haltepunkte z. B. aktivieren oder deaktivieren als auch löschen. 

Error Call Stack – Nutzen Sie den Error Call Stack als Hilfe zum Debuggen 
Ihres VEE-Programms. Im Error Call Stack werden das UserObject bzw. die 
UserFunction angezeigt, wo der Fehler auftritt. Außerdem zeigt der Error
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Call Stack auch in einer Liste oder Hierarchie an, welches UserObject 
oder welche UserFunction das derzeit ausgeführte Objekt aufruft, in dem 
der Fehler auftritt.

Integrierte Datenbankunterstützung -- Mit dieser Funktion können Sie 
mühelos zu jeder von ADO.NET unterstützten Datenbank eine Verbin-
dung herstellen, z. B. Microsoft Access, Microsoft SQL Server, Oracle, 
MySQL etc. Sie können in dieser Datenbank große Testdatenmengen in 
gut strukturiertem Format speichern und dann bei Bedarf jederzeit zu 
Analyse- oder Testzwecken abrufen. 

LXI-Unterstützung – Alle LXI-Instrumente verfügen über eine 
Web-Schnittstelle, die nützliche Informationen über das Instrument bie-
tet, eine Standardmöglichkeit zur Konfiguration der LAN-Schnittstelle 
sowie weitere Funktionen. Agilent VEE bietet eine komfortable Möglich-
keit zum Öffnen einer LXI-Web-Schnittstelle eines Instruments in einem 
VEE-integrierten Web Browser. 

Verbesserter Default Preferences-Dialog – Das Default Preferences-Dia-
logfenster wurde umgestaltet und verbessert, damit Sie nicht nur in den 
Genuss einer modernen Programmiererfahrung, sondern auch ver-
besserter Funktionalität kommen. 

Erweiterte Unterstützung für benutzerdefinierte Menüs – Neben dem 
Textformat unterstützt Agilent VEE 9.0 auch das XML-Format. Außerdem 
finden Sie in Agilent VEE 9.0 auch zwei Tools für benutzerdefinierte 
Menüs, mit denen Sie benutzerdefinierte Menüs bearbeiten und vom alten 
Textformat in das neue XML-Format konvertieren können. 

Neue Symbolleisten für VEE-Objekt – Einigen häufig verwendeten 
VEE-Objekten werden ein neuer Satz von Symbolen sowie einige neue 
Symbolleisten zugeordnet. Sie können ein VEE-Objekt leichter in diesen 
Symbolleisten als im Hauptmenü auswählen. 

Unterstützung für NaN und Infinity -- Agilent VEE 9.0 unterstützt NaN 
und +/-Infinity für die Datentypen Real64 sowie Real32 und bietet vier 
integrierte Funktionen: isNaN, isInfinity, isNegativeInfinity, isPositiveInfi-
nity. VEE beherrscht die NaN-/Infinity-Konvertierung von Zahlen in Zei-
chenfolgen und umgekehrt und ermöglicht NaN und Infinity in .NET und 
MATLAB die Ausgabe an VEE und umgekehrt.

Neue Beispiele – Neue Agilent VEE-Beispiele für einige häufig verwen-
dete VEE-Objekte verhelfen Ihnen zu einem schnellen, mühelosen Ler-
neinstieg.
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Agilent-Konnektivitätsprodukte

Agilent bietet eine umfassende Palette von sehr leistungsfähigen und 
zuverlässigen Produkten an, über die PCs mit Instrumenten verbunden 
werden können. Dazu gehören ein netzwerkbasierter USB-Hub, ein 
LAN/GPIB-Gateway sowie PCI/GPIB-, USB/GPIB- und USB/RS232-
Schnittstellen. Weitere Informationen zu den Konnektivitätsprodukten 
von Agilent finden Sie hier: www.agilent.com/find/io.

Agilent-Unterstützung, -Dienstleistungen und 
-Aktualisierung

Mit Agilent VEE Pro und Agilent VEE Express haben Sie Zugriff auf die 
weltweiten Agilent-Ressourcen für die Erstunterstützung, für Schulungen 
und für Aktualisierungen. Mit dem Kauf irgendeines Agilent VEE-Pro-
dukts erwerben Sie das Recht, kostenfreie technische Unterstützung zu 
erhalten. Eine Registrierung ist nicht erforderlich. 

Agilent bietet weitere Beratungsdienstleistungen an. In den USA, in Eur-
opa und im Nahen Osten gibt es momentan mehr als 30 Unternehmen, 
von denen Sie beim Entwickeln von Agilent VEE-Lösungen unterstützt 
werden können.

Melden Sie sich für die elektronische Agilent VEE-Benutzergruppe unter 
http://www.agilent.com/find/vrf an. Hier erhalten Sie von Experten auf 
der ganzen Welt Hilfe zum Arbeiten mit Agilent VEE.
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Anhang
Agilent VEE Pro Help steht jetzt auch in anderen Sprachen zur Verfügung. 
Um Online-Hilfedateien in anderen Sprachen zu nutzen, führen Sie bitte 
folgende Schritte aus: 

1 Laden Sie die lokalisierte Online-Hilfe unter 
www.Agilent.com/find/vee herunter.

2 Speichern Sie heruntergeladene Dateien im Installationsverzeichnis 
von Agilent VEE. In der Regel ist dies C:\Programme\Agilent\VEE Pro 9.0. 
Ändern Sie die Namen der heruntergeladenen Online-Hilfedateien 
bitte nicht.

3 Öffnen Sie Agilent VEE.

4 Öffnen Sie „Default Preferences“ (File => Default Preferences). Wählen 
Sie die gewünschte Hilfedateisprache auf der Registerkarte „Help“.

5 Klicken Sie auf „OK“, um das Dialogfenster „Default Preferences“ zu 
schließen.

Microsoft ist eine in den USA eingetragene Marke der Microsoft Corporation.
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Agilent Technologies

Kontaktdaten
Um unsere Services, Garantieleistungen oder 
technische Unterstützung in Anspruch zu neh-
men, rufen Sie uns unter einer der folgenden 
Telefonnummern an:

Vereinigte Staaten:
(Tel) 800 829 4444            (Fax) 800 829 4433
Kanada:
(Tel) 877 894 4414            (Fax) 800 746 4866
China:
(Tel) 800 810 0189            (Fax) 800 820 2816
Europa:
(Tel) 31 20 547 2111
Japan:
(Tel) (81) 426 56 7832       (Fax) (81) 426 56 7840
Korea:
(Tel) (080) 769 0800          (Fax) (080) 769 0900
Lateinamerika:
(Tel) (305) 269 7500
Taiwan:
(Tel) 0800 047 866            (Fax) 0800 286 331
Andere Länder im Asien-Pazifik-Raum:
(Tel) (65) 6375 8100          (Fax) (65) 6755 0042

Oder besuchen Sie uns im Internet:
www.agilent.com/find/assist

Änderungen der Produktspezifikationen und 
-beschreibungen in diesem Dokument vorbe-
halten.
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